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Exam: 70-272 Certification Questions & Answers I

Question 1:

You are a desktop support technician for your company. All client computers run Windows
XP Professional.

Jane and Sam share a computer named Client001. Jane has shared a folder so that Sam
can view files within the folder. The folder is shared as JanesFiles. The exhibit displays the
NTFS permissions that are configured for JanesFiles. (Click the View Exhibit)
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However, Sam reports that he is unable to access the files within the folder. Jane needs to
provide Sam with the appropriate level of access to the files.
Which of the following should you instruct Jane to do?

A. Instruct her to modify the NTFS permissions.
B. Instruct her to modify the share permissions.
C. Instruct her to create a local user account for Sam on her computer.

D. Instruct her to add Sam's domain user account to the Local Administrators group on her
computer.

Answer: B

Question 2:

You work as the network administrator at TestKing.com. TestKing.com has a domain named
testking.com. All servers on the TestKing.com network run Windows Server 2003 and all
client computers run Windows XP Professional. TestKing.com has a computer named
TESTKING-SRO01 configured as the VPN server using IPSec connections.

TestKing.com has a Marketing division which uses TESTKING-SRO01 using a L2TP
connection. During the course of the day the Marketing division state the L2TP connection
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has failed.

How would you configure the connection used to ensure that the Marketing division is able
to access TESTKING-SR01?

A. By configuring the connection type to PPTP VPN.

B. By configuring the connection to use the Public Key Infrastructure (PKI).
C. By configuring TESTKING-SRO1 to use additional PPTP ports.

D. By configuring the connection type to SSTP VPN.

Answer: A

Explanation:
IPSec is not used, so L2TP connections should not be used either. Instead reconfigure to
use PPTP VPN.

Question 3:

You work as the network administrator at TestKing.com. TestKing.com has a Windows XP
Professional computer named TESTKING-WS270 configured with Microsoft Office XP to
use the animated characters in the help menu.

How would you configure TESTKING-WS270 to disable these animated characters?

A. By configuring accessibility options in conjunction with Microsoft Office.

B. By having the Microsoft Office assistant deleted from the System 32 folder.

C. By opening Microsoft Office to access the Options menu and selecting Hide the Office
Assistant option.

D. By right-clicking the animated character and selecting Options to disable the animated
character by clearing the Use the Office Assistant check box.

Answer: D

Explanation:

The Office Assistant is a feature included in Microsoft Office starting with Microsoft Office 97,
and has been dubbed " Clippy " or " Clippit " after its default animated paperclip
representation. However, Clippit is actually the default assistant's official name. Right-
clicking on the character and selecting Hide will only remove the assistant temporarily.
Manually removing . dll files from the system is never a good way to solve a problem as this
could cause more problems. Selecting Hide the Office Assistant from the Help menu is the
same action as right-clicking on the assistant and selecting Hide. Clearing the Use the
Office Assistant from the Options menu when right-clicking the assistant is the correct way to
permanently remove the Office Assistant.

Question 4:

You work as the network administrator at TestKing.com. TestKing.com has a domain named
testking.com. All servers run Windows Server 2003 and all client computers run Windows
XP Professional. TestKing.com has a client computer named TESTKING-WS272 configured
with Microsoft Office XP shared by the Finance and Marketing division.

TestKing.com has recently added an additional physical hard disk to TESTKING-WS272.
Now when Finance and Marketing division users attempt to install additional features for
Microsoft Office through the Add or Remove Programs console, they receive an error
message stating that the Installer package cannot be located on the CD-ROM drive even
though the Installation CD is inserted into the drive.

How would you configure TESTKING-WS272 to resolve this problem?
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A. By using the newly installed physical hard disk in the prompted path drive letter.
B. By having the .msi file extension configured in the prompted path.

C. By having the .pst file extension configured in the prompted path.

D. By having the CD-ROM drive configured in the prompted path drive.

Answer: D

Explanation:
The user has installed a new hard drive. This has caused the drive letter that refers to the
CD-ROM drive to change.

Question 5:

You are the desktop support technician for your organization. A user has password-
protected an important document using the security features built into Word 2003.
Unfortunately, he cannot remember the password that he used. He did not write it down and
did not tell anyone else.

He wants you to override the system so that he can obtain his document. Which of the
following should you tell him?

A. You are not authorized to override the system; he will have to talk to the network
administrator.

B. There is nothing that anyone can do; he will have to either remember the password or re-
create the document.

C. He can override the security simply by creating a document with the same name as the
one that is password-protected.

D. Overriding the security will mean that he will have to change his username and password
on the network as well.

Answer: B

Question 6:

John works as a Network Administrator in Testking.com. The company uses a Windows
Server 2003-based domain. All users connect to the Internet regularly. One of the users
complains to John that he is unable to connect to the Internet and any Internet query
produces the following error message:

The Page Cannot Be Displayed

Other users do not have any such issue. When John runs the IPCONFIG command, he finds
that the IP address of the computer is 169.254.0.5 and the subnet mask is 255.255.0.0.
What is the most likely cause of the issue?

A. John's computer is unable to get IP address lease from the DHCP.
B. The network adapter is not functioning properly.

C. TCP/IP is not installed on the computer.

D. The DNS server is not working on the network.

Answer: D

Question 7:

You work as the network administrator at TestKing.com. TestKing.com has a domain named
testking.com. All servers run Windows 2000 Server and all client computers run Windows
XP Professional Service Pack 2 (SP2). TestKing.com has a client computer named
TESTKING-WS272 shared by the Marketing division to browse the Internet. A member of
the Marketing division customized the Internet Explorer toolbar.

How would you restore the toolbar?
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A. By opening the Internet Options Advanced tab in Internet Explorer to click the
automatically check for Internet Explorer updates button.

B. By opening the Internet Options Advanced tab in Internet Explorer to click enable Install
on demand (Internet Explorer) button.

C. By opening the Internet Options Advanced tab in Internet Explorer to click the enable
personalized Favorites Menu button.

D. By opening the Internet Options Advanced tab in Internet Explorer to click View menu on
the Internet Explorer and point to Toolbars, and select Customize in order to use the Reset
button.

Answer: D

Explanation:

Resetting the toolbars will set them to their default configuration. Any buttons that were
added will be removed, and any that are missing will be added again. Note that this will
make the toolbars appear as they did when Internet Explorer was originally configured.
Incorrect Answers:

A: Restoring the defaults from the Advanced tab will not reset the toolbars. These settings
affect things like image place holders, whether a site's certificate is checked for revocation,
and enabling the java compiler among other things.

B: Resetting the web settings will reset what program opens when a news link is clicked, a
web page is selected to be edited, or what program opens when an email link is clicked. It
will not affect the toolbars.

C: Locking the toolbars will prevent changes to the toolbars, but will not change the toolbars
back to their original configuration.

Question 8:

You are the desktop support technician for a company that has many users in many different
locations. All users are using Windows XP Professional client software. You want to set up a
program whereby you will train certain users who will then be able to assist other users over
the network. You want the novice users to have to invite the expert users before the expert
users can help. Which remote connectivity tool should you use?

A. Remote Desktop

B. Dynamic Host Configuration Protocol
C. Remote Assistance

D. WINS

Answer: C

Question 9:

You work as the network administrator at TestKing.com. TestKing.com has a domain named
testking.com. All server run Windows Server 2003 and all client computers run Windows XP
Professional Service Pack 2 (SP2). TestKing.com has a client computer named TESTKING-
WS272 used by Marketing division members. TESTKING-WS272 has the vast amount of
Web sites in the Favorites list.

How would you configure TESTKING-WS272 to make finding a Web site in the Favorites list
easier?

A. By having the Favorites list sorted by name.

B. By deleting the un-required web sites from the Favorites list and selecting the Show
Related Links option to open the Favorites list.

C. By deleting the un-required web sites from the Favorites list and moving the rest into
folders.

D. By deleting the un-required web sites from the Favorites list and export her Favorites list
to an Access database file to run a query against.
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Answer: A

Explanation:

The simple answer is the correct answer. Simply sort the Favorites by name. Click Favorites,
then right click on any of the favorites listed, and choose Sort by Name.

Incorrect Answers:

B: There is no "Related Links" setting on the Tools menu.

C: Organizing similar web sites into folders may help but not as much as listing Favorites by
name.

D: Exporting the Favorites to an Access database file could work if the favorites were
reordered in the word processing program, but would be labor-intensive and not the best
solution.

Question 10:

You are the desktop support technician for a large organization with many users. A user
named Tom has recently been promoted to executive. With this promotion, he is supposed
to have access to the executive files. Tom complains that although he can log on to the
domain, he still does not have access to the executive files. You verify with the network
administrator that Tom's account has been added to the executive group, which has
permissions to the files. Other executives are currently able to access and use the files.
Which of the following could be causing this problem? (Choose all that apply.)

A. Tom is a member of group that is explicitly denied permissions to the executive files.
B. The domain controller is logging Tom on with cached credentials.

C. Tom has not restarted his computer.

D. The server with the executive files is not available.

Answer: A,B

Question 11:

You work as the network administrator at TestKing.com. TestKing.com has a domain named
testking.com. All servers on the TestKing.com network run Windows Server 2003 and all
client computers run Windows XP Professional with Microsoft Office XP. TestKing.com has
two computers named TESTKING-SRO01 and TESTKING-SRO02 configured as follows:

TESTKING-SROL1 - configured as a DNS server accepting dynamic updates.
TESTKING-SRO02 - configured as a File server used by the Marketing division.

How would you configure a newly installed File server replacing TESTKING-SRO02 if the
Marketing division members are unable to connect to TESTKING-SR02?

A. By running the netstat -c command on TESTKING-SRO02.

B. By running the ipconfig /flushdns command on the client computers Lang's client
computer.

C. By running the ipconfig /release command on TESTKING-SR02.

D. By running the ipconfig /registerdns command on TESTKING-S02.

Answer: B
Explanation:

You must do a flushdns command because the server was replacement online a few
minutes so the DNS information is old.

Question 12:

You are a desktop support technician for your company. All employees use Windows XP
Professional computers with the Microsoft Office 2003 suite installed. Elizabeth, a member
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of Marketing, calls because she needs to restore the default icons for Microsoft Word.
Previously, you created several custom shortcuts for Elizabeth, and she wants to retain
them.

What should you instruct Elizabeth to do first?

A. Instruct her to run Detect and Repair from within Word and use the default settings.

B. Instruct her to run Detect and Repair from within Word and clear Restore my shortcuts
while repairing.

C. Instruct her to run Reinstall or Repair for Microsoft Office 2003 from within the Add or
Remove Programs applet in Control Panel and select Repair.

D. Instruct her to run Reinstall or Repair for Microsoft Office 2003 from within the Add or
Remove Programs applet in Control Panel and select Reinstall.

Answer: A

Question 13:

John works as a Network Administrator in Testking.com. The company is using a Windows
Server 2003- based domain with Windows XP Professional installed on all computers of the
company's network. All the computers are using the NTFS file system. The company policy
states that all users must be prohibited from performing the following tasks:

1. Configuring TCP/IP advanced configuration

2. Deleting remote access connection

3. Configuring properties of LAN connection

4. Editing registry tools

What will John do to ensure this?

Each correct answer represents a part of the solution. Choose two.

A.

B. Open the Group Policy console. In the left pane, expand the User Configuration,
Administrative Templates, and Windows Components. From the right pane, choose the
required items and enable them.

C.

D. Open the Group Policy console. In the left pane, expand the User Configuration,
Administrative Templates, and System. From the right pane, choose the required items and
enable them.

E.

F. Open the Group Policy console. In the left pane, expand the User Configuration,
Administrative Templates, and Start Menu and Taskbar. From the right pane, choose the
required items and enable them.

G.

H. Open the Group Policy console. In the left pane, expand the User Configuration,
Administrative Templates, and Network Connection. From the right pane, choose the
required items and enable them.

Answer: B,D

Question 14:

You work as a desktop adminsitrator at TestKing.com. TestKing.com has a domain named
testking.com. All servers run Microsoft Windows 2000 server and the client computers run
Microsoft Windows XP Professional.

TestKing.com has a Marketing division which makes online purchases during work hours.

How would you configure the network firewall to stop these activities whilst allowing the
Marketing division to access the Internet?

A. By having port 110 blocked on the firewall.
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B. By having port 443 blocked on the firewall.
C. By having port 143 blocked on the firewall.
D. By having port 21 blocked on the firewall.

Answer: B

Explanation:
Port 443 is used for Secure Sockets Layer connections to Secure HTTP Web sites. This port
should be blocked.

Question 15:

Jessica works as a Network Assistant in Testking.com. She complains that whenever she
opens a folder or clicks an icon in the Control Panel, a separate window is opened.
Sometimes ten to fifteen windows are opened and she finds it quite annoying. She wants to
open each folder in the same window. What will she do to accomplish this?

A. On the General Tab page of the Folder Options dialog box, select Open each folder in its
own window from the Browse Folders section.

B. On the General Tab page of the Folder Options dialog box, select Show common tasks in
folders from the Tasks section.

C. On the General tab page of the Folder Options dialog box, select Use Windows classic
folders from the Tasks section.

D. On the General Tab page of the Folder Options dialog box, select Open each folder in the
same window from the Browse Folders section.

Answer: D
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